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INVIA, LLC has taken care to ensure the accuracy of this document. However, this party assumes no
liability for errors or omissions and reserve the right to make changes without further notice to any
products herein for any reason. The party provides this guide without warranty of any kind, either implied
or expressed, including, but not limited to, the implied warranties of merchantability and fitness for a
particular purpose, may make improvements or changes in the product(s) and/or program(s) described
in this guide at any time. All statements, technical information and recommendations in this guide are
believed reliable, but the accuracy and completeness are not guaranteed or warranted. The information
in this guide is not intended to be, nor should it be understood to be, representations or warranties
concerning the software described. INVIA, LLC shall not be liable nor obligated in any manner in
respect of bodily injury and/or property damage arising from the use of this software if such use is not
in strict compliance with instructions and safety precautions contained in the relevant operation guides
and in all supplements thereto, in all product labels, and according to all terms of warranty and sale of
this software, nor if any change not authorized by the above-identified parties is made to the software
contained herein.

This software and related guide contains confidential and/or proprietary information which is protected
by copyright and international treaty provisions. All rights are reserved. No part of this guide may be
photocopied, reproduced, or translated to another language without written permission from INVIA,
LLC. Any unauthorized use, disclosure, assignment, transfer or reproduction of this confidential
information will be prosecuted to the full extent of the Law.

INVIA, LLC reserves the right to revise this publication and to make changes in content from time to
time without obligation to provide notification of such revision or change.

User provided programs or scripts are NOT validated nor warranted by the above-identified parties. The
use of data obtained using such user provided programs or scripts is the sole responsibility of the party

using such programs or protocols. Users exchanging files and diskettes should beware of the risk of
Federal law restricts this

/ device to sale by or on

the order of a physician. CorridordDM is a registered trademark of INVIA, LLC.

software viruses.
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GETTING STARTED

4DM Personal’s Patient Browser provides an intuitive file management
interface for data access and management. Users can receive, export, and
query/retrieve DICOM part 10 image files through DICOM connectivity
to network connected workstations. The patient browser provides DICOM
file import and export capability to local and network directories. The
patient browser permits the user to filter, edit, and select the data to pass to
an application (e.g. 4DM).

4DM Personal’s Patient Browser is a comprehensive data access, transfer and file management system

for medical imaging data. Its simple and intuitive interface provides an environment where users can

perform a variety of image file management operations such as store, import, receive, and transfer files

between local, shared, and DICOM nodes and perform DICOM Query/Retrieve operations.

Finally, the patient browser provides a gateway to 4DM — an advanced visualization, quantification, and

reporting software solution by selecting 4DM from the patient browser’s application panel.

You can use the patient browser to do the following:

Receive and store DICOM image files sent by remote DICOM nodes to a local or network
connected database or directory.

Receive Pegasys file formatted images stored to an SCP directory and convert them to an INVIA
native DICOM image format.

Receive ECAT file formatted images stored to an SCP directory and convert them to an INVIA
native DICOM image format.

Automatically import DICOM image files stored within a defined directory.

Query/retrieve a list of DICOM image files from remote DICOM nodes to a local or network
connected database, or a directory.

Export DICOM image files to local or networked databases and/or directories.
Export DICOM image files to a remote DICOM node supporting DICOM store.
Export DICOM image files to external media (CD, DVD, and USB drive).
Manage multiple databases and/or directories to organize patient data for review.

Set a search filter for a database or directory to display data based on Patient, Study, and Series
information in the DICOM file.

Edit DICOM image files to correct user input errors.
Start a new report when a patient image file does not yet exist
Access 4DM Reporting to edit an existing report

Merge two patient files into one
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More detailed
instructions for product
installation can be found
on the Training and
Support pages at
www.inviasolutions.com

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE

Throughout this guide, INVIA will rely on consistent use of terminology and symbols to best communicate
with you, the end user. Below is a summary of these conventions:

= Blue, underlined text represents links to help you quickly navigate within this document or
launch online content (Internet access required).

= Helpful hints, warnings, and additional information, which appear in the left margin for quick
and easy reference, are identified by various symbols:

Right Click
/ Note ! Warning & Tip '8 ¢

Option

The user’s manual and user interface will rely on the following abbreviations:

Abbreviation Description

AE Title Application Entity Title identifies the DICOM nodes communicating between
each other.

DICOM Digital Imaging and Communications in Medicine (DICOM) is a standard for
handling, storing, printing, and transmitting information in medical imaging.

1P Internet Protocol is a unique identification number, such as 127.0.0.1, for
devices (computers, printers) within a network.

SCP Service Class Provider

SCU Service Class User
Windows® 7 (64-bit)

Supported Operating Windows® 8 (64-bit)

S " | Windows® 10 (64-bit)
ystems: Windows® Server 2008 R2
Windows® Server 2012 R2

Processor Speed: | 2.0 GHz or greater

Memory: | 3 GB recommended

Disk Space: | 1 GB required for installation; 2-4 GB additional disk space for image files

1280x1024 or higher recommended

Display:
SPRY 54 bit color

256 MB or higher recommended

3D Graphics Card:
raphies tat 3D graphic card supporting OpenGL 3.0 is recommended

Networking: | Networking adapter card (ethernet or wifi) required

1. Close any previous versions of the patient browser and 4DM that are open.
2. Insert the installation CD into your computer’s CD drive or place the USB into the USB port
3. From within the 4DM_Welcome file, click on Install 4DM.
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http://www.inviasolutions.com

S.

The Licensing window
can also be accessed
from the Windows Start
Menu. Select INVIA and
then INVIA Licensing.

(2]

Left-click About from
the Help menu to review
the patient browser’s
product information, a
summary of licensing
information, and to
access this User’s Guide.
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Fixed License Model (Figure 1.1)

Hardware ID: This is a unique identifier
specific to the workstation to which 4DM
is licensed.

File Location: When licensing a fixed
installation, the user can navigate to
the directory folder where the 4DM
fixed license key file is located. Once
Check Status is selected, 4DM will
automatically copy the license file to
the 4DM application directory and
display the file path.

Status: Displays any messages regarding
the validation of the license key file.

Available Features: Lists the features

defined by the license key.

Floating License Model (Figure 1.2)

IP Address and Port: User enters the IP
Address and Port number for the license
manager. Select Check Status to verify
connection to the license manager.

Server Information: Displays the active
license manager address, total number of
licenses on the license manager, and the
number of licenses in use. The Details
button provides more information about
the license manager.

Status: Displays any messages regarding
the validation of the license key file.

Available Features: Lists the features

defined by the license key.

4. Follow the on-screen installation instructions.

Licensing window will change based upon selection.

To launch the patient browser, select Corridor4DM from the INVIA tab in your program list
in the Start Menu.

In order to run 4DM Personal, you must have a valid license key. The application supports both fixed and
floating licenses. To open the Licensing window, open the patient browser and select Licensing from
the Help menu. Users have the option to select the site-specific license model type. The fields within the

In orde
¥OUr Sal8S Fepresantitve

Licanse Model

File Location:

Aunlakis Fostures

Hardware ID;

license ey, To obtain avalid license, Send arequestio

@ Fond

#0100 A2 INRIG IO pndlond

Check Status

Figure 1.1:

The Licensing window - Fixed License

Lcense Model

1P Address

Server informaon

Status

Fralable Featurns.

Fooed @ Fostrg

123 458 ™ 10

Total Number of Licenss: 3
Musber of Active Licanses:
Cousted by Workatatmn

The kcerwe ey i vabd.

FRecenstruction v2016
Mtion

Figure 1.2: The Licensing window - Floating License
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Floating License with Backup Model (Figure 1.3)

represertative. H
@ Primary Server IP Address and Port:
User enters the IP Address and Port S - aET
. Pamary Secver IP Addwes: 123 458 TH 1w Pot: sl [ Check Sttus |
number for the license manager. Select T S I e e
Check Status to verify connection to the B RS
license manager. el
SF!UPmmun;uzmi
PET Processing v2016
@ Backup Server IP Address and Port: ey e
User enters the IP Address and Port
number for the license manager that is
designated as the backup server. Select
Check Status to verify connection to the = ][

backup license manager. Figure 1.3: The Licensing window - Floating

. . License with Backup
€© Status: Displays any messages regarding

the validation of the license key file.

@ Available Features: Lists the features defined by the license key.
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CHAPTER 2 | NAVIGATING THE PATIENT BROWSER

For help retrieving files This chapter guides users through the basic features and functionality of 4DM Personal’s Patient Browser
from remote DICOM while accessing patient files from local and shared directories.

nodes, go to Chapter 5:

DICOM Configuration.

First, the user should become familiar with the application’s user interface (Figure 2.1 ). The menu bar at
the top of the interface includes the File, Tools, and Help menus. The interface is designed to flow from
left-to-right, with three areas: Sources, Search/Patient List, and Applications/Destinations.

= Sources — The left side of the patient browser interface provides a list of data sources.
Navigate local or shared directories within the Local tab and DICOM-connected
workstations within the Remote tab to access patient datasets. Add local and DICOM
folders and databases to the Sources panel for easy access.

= Search/Patient List — The center area of the patient browser interface allows users to
filter imaging data by applying search parameters or by prioritizing according to file
characteristics. Select one or multiple items from the patient list for review or transfer.

= Applications/Destinations — The right side of the patient browser interface applies actions
to patient files. Launch a patient file in 4DM for review, start or edit reports, merge patient
files, or copy files to local or remote destinations.

. . Applications/
Sources Search / Patient List P
Destinations
Fiie Tooi Felp
Lecal | pemete
Sources Search Applications.
2 Fasent Hame Leresseam Humaer =)
‘.‘: Patent 1D Study Description: S’ IEW 2006
O B Castsbase setms Modaity Series Descripbon =
L] CoProgramBusfocuments B orridordOi Samplelata Sy Db (A GoMe =3 =llrb =208 =] st [33 =l[Fet  =llz08E = E—J A0k Roaponiog
patont List
(5 Y Y =[E]F = -
e | )
7 Marge Panent
T [ Usarfacats  moruass  Lacates !
U GBS 001 OLOIEGETEAA . WMap IS CPragramData Documenty VI Cormeor AN S prpiel
DM PET CFRLO04 B3-501 RBEI-CF 18-0ct-2008 1 CProgramlete Documenta VIS Carron SO0 Sampiel Das
o pemeon DOLIARBET Y. KRMap1008 1 € Pragearinta DocumestyiN A Cardor AN Sarci
U SPECTA0N 400V IDGER 0. MINT 1 CPra g ImON DOCUme MY Ao S prpiel:
U SPECT-CT.0N DD GSRe.  ZMapIT 1 CPregramDas Cocume e VI G e r N S el &
s O MW Oasvase detiunt
1y Caomputar ] O % oicou cani

Figure 2.1: The patient browser screen contains File, Tools, and Help menus, and three areas for user interactions:
Sources, Search / Patient List, and Applications / Destinations

Menu Bar

The top menu bar contains File, Tools and Help

File | Tools Help
File (Figure 2.2) Exit

= Exit: Exits the patient browser

Figure 2.2: File Menu
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You can load studies

from multiple sources

at the same time. The
& patient browser will load

studies from each source

that is selected.

Tools (Figure 2.3)

= Database Manager: Described in Chapter 4

= Local SCP Configuration: Described in Chapter 5

DICOM Node Configuration: Described in Chapter 5

Tools] Help

Database Manager

Local SCP Configuration
DICOM Mode Configuration
Job Queue Manager

= Job Queue Manager: Described in Chapter 2

= Preferences: Described in Chapter 6

= Auto Import: Described in Chapter 5

. . o
Help options (Figure 2.4) | (Fe]
I About
= About: Provides patient browser product information, Licensing
. . . . Event Viewer
Language Setting, License Information, Feature List and L

User Guide button
= Licensing: Described in Chapter 1

= Event Viewer: Described in Chapter 5

Preferences

Auto Import

Figure 2.3: Tools Menu

Figure 2.4: Tools Menu

= 4DM Personal’s Patient Browser Log Viewer: Described in Chapter 5

Sources

The installation process creates a default database on your local drive and loads sample files to a folder on
your system. These two locations appear as shortcuts in the top left panel of the application (Figure 2.5).
To browse for local folders with stored DICOM files, simply navigate to the desired location using the
folder structure directory in the bottom panel of the Local Sources tab (Figure 2.6).

Local | Remote|

Sources

O . Database: default
[ q=| C\ProgramData\Documents\IMVIACorridordDM\SampleData

@

= 5| Wy Computer
E| _=| System (C:}
-7 Public
q=| Desktop
El _=| Documents
257 mvia
© &7 corridor4Dnt
=7 4DMOpenGL
1 _=| colorbars
1 _=| local
1 _Fl reportFinal
4 _=| reporfTemplates

= B

-

Figure 2.5: This area displays shortcuts to local folders.

To Select Local Data Sources

= Click on the desired database
or directory so it is selected
(Figure 2.7). Click the Refresh
tool (Figure 2.8) in the Patient
List Panel to display a list of
patient files.

Figure 2.6: An example of the folder directory panel.

||i| ,=] C\ProgramData\Documents\NVIACorridordDMSampleData

Figure 2.7: Selected Local Source

Patient List

S| ]| e

Figure 2.8: Patient List Panel

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE
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Save time when loading
studies — put your most

& frequently used databases
and folders in the
Sources menu.

Search parameters are
not case sensitive. A

/ search for ABC will
return the same results as
Abc or abe.

Search Parameters and
use of the Wildcard (*):

= abc — Returns items
that exactly match

« i)

abc

= abc* - Returns all
items that match the
characters before the
asterisk (*); all other
characters are ignored
(e.g., abc, abed, abede,

& etc).

= *abc — Returns all
items that match the
characters after the
asterisk (*); all other
characters are ignored
(e.g., mabc, nabc,
oabg, etc).

= *abc* — Returns all
items that match the
substring “abc” (e.g.,
abed, dabc, fabeg,
etc.)

To Create a New Source Directory

= Click the Add Local tool (Figure 2.9). Select the desired T —
directory and click OK. The new Directory will appear in ﬂ

Figure 2.9: Add Local tool in
Local Sources Panel

the top Local Sources panel.

To Navigate to a Local Directory (local or mapped drives)

= Navigate to the directory and folder of your choice. Click on the desired destination so it is
highlighted blue. Click the Refresh tool in the Patient List Panel to display a list of patient
files.

Search/Patient List

The center of the patient browser interface provides the Search panel and Patient List panel.

Search Panel

The Search panel (Figure 2.10) can be used to search a large database for patient studies. The search
criteria can be set by Patient Name, Patient ID, Modality, Study Date, Study Description or Series

Description.
Search
Patient Name: Accession Mumber: L’\;\
Patient ID: Study Description: W‘]
Modality: Series Description:
Study Date: Al Dates - |12 Mar 2012 and 12 Mar 2012

Figure 2.10: The Search panel in its default state

Enter the search qualifiers into the various text fields and then click the Refresh tool in the Patient List
panel. For examples, see the Tip in the left-column.

The only field that is not text based is the Study Date. This field uses a drop-down menu to set the
parameters for the search and a pop-up calendar for date selection (Figure 2.11):

= All Dates: Query does not restrict returned files according to dates.

= On: Query will return only studies performed on the specified date.

= Before: Query will return only studies performed before the specified date.

= After: Query will return only studies performed after the specified date.

= Between: Query will return only studies performed between the two specified dates.
= Today: Query will return only studies performed that day.

* Yesterday: Query will return only studies performed on the previous day.

= Last 2 Days: Query will return all studies performed within the past two days.

= Last 7 Days: Query will return all studies performed within the past seven days.

IStudy Date H [Mar  ~][2012 ~| ang Mar v |[2012 +
All Dates
On

Cam) % Before it =

|| Nepe = [

I Today

ame “Yesterday Most Recent S...  # of Studies Location
'I:Esﬁ BEYS 22-May-2007 1 C:\ProgramData\DocumentsVNVIAICorT
ast 7 Days

ic2 Y 09-Mar-2007 1 C\ProgramData\Documents\INYIA\Corri

Figure 2.11: The Study Date area includes a drop-down menu of the various parameters
for a Study Date search and drop-down menus for day, month, and year.
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The patient browser will
conduct the following
date-based searches
according to your
computer’s date setting:

= Today

= Yesterday
= Last 2 Days
= Last 7 Days

The end user has the
ability to copy/paste the
patient list into other
applications such as
MSWord, Notepad, Excel
and other documents

that support copy/paste
of text.

By default, the file list
will be organized by the
Patient Name column,
starting with numerical
file names and then
alphabetic file names.

When a patient or
multiple patients are
selected, the Study,
Series, and Instance
Views will apply only to
those selected patients.
Return to the Patient
View to see all available
patients.

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE

Click the Reset tool (Figure 2.12) to clear all fields. L\?“ Figure 2.12:

\ﬂ Reset tool

Patient List Panel

The Patient List panel displays available files from the selected source(s) or source location(s)

(Figure 2.13).

4D SPECT-CT,001 004-003,1D GS/R+CaSc (CaSc)  22-May-2007

A Patient Name Patignt ID Most Recent S...  # of Studies  Location

4DM GBPS,001 004-018,GBPS/ILAD (MUGAZ) 20-May-2009 1 C:\Userg\Public\Documents\INVIA\CerridordDM\SampleDatal...

4DM PET CFR,004 003-003,RB&2+CFR (CFR4) 28-0ct-2009 1 CAUsers\Public\Documents\INVIA\Corridor4DM\SampleDatal...

4DM PET,001 004-014 RB32 (PET Abnormal) 02-May-2008 1 Chlzers\Public\Documents\NVIA\CorridordDIM\SampleDatal...

4A0DM SPECT, 001 004-001,1D GS/R (lschemic2) 09-Mar-2007 1 CAUsers\Public\DocumentsiNVIA\Corridor4DSampleDatal...
1

CAUsersi\Public\DocumentsiiNVIA\CorridordDM\SampleDatal...

Figure 2.13: Patient List

This area contains five User Control tools (Figure 2.14) and four File View tools
(Figure 2.15):

= Refresh (Double Arrows): Populates or updates the list with files from the
selected source as filtered according to the search parameters.

= Stop Refresh (Double Arrows with Hand): Cancels the patient list update
action initiated by the Refresh button.

= Select All (Cursor Arrow with a Check Mark): Selects all of the displayed
patient files within the patient list.

= Unselect All (Cursor Arrow with a Minus Sign): Deselects all of the
displayed patient files within the patient list.

= Delete Selected Dataset(s) (Trash Can): Deletes the selected file(s) from
the patient list and the source directory.

= Patient (Person): Displays Patient Name, Patient ID, Most Recent Study
Date, Number of Studies, and Location within the display list.

= Study (Scanner): Displays Patient Name, Patient ID, Study Date, Study
Description, Modalities, Number of Series, and Location within the display
list.

= Series (Single X-Ray): Displays Patient Name, Patient ID, Modality,
Series Date, Series Description, Number of Images, and Location within
the display list.

= Instance (Two X-Rays): Displays Patient Name, Patient ID, Modality,
Instance Date, Instance Description, and Location (only available within
local mode).

By clicking on the column header in the Patient List panel, the list will sort according
to that field. The sort order is designated with a small black triangle. A single click
will organize the information in ascending order, and a second click will reverse the
order. The columns can be resized by clicking-and-dragging on the column border.

.-':::\‘
L6
=

]

& )&

1
o i’

"

Figure 2.14: User
Control tools

2

tI-l.m:!

gl

Figure 2.15: File
View tools
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Select multiple files

at once to save time.
Hold the shift key while
selecting the first and last
in consecutive list. Hold
the control key [Ctrl]
while selecting multiple
inconsecutive items.

WARNING

Changing Patient Name,
Patient ID, Birth Date,
and Gender can affect
diagnostic results.

Edit Command Line
Arguments:

Right-click on the 4DM
application button to
launch the editor (Figure
2.17).

The user can edit the
command line to select a
specific user workflow to
always launch when the
4DM application button
is selected, e.g. -user
DrSPECTReview.

This command will
launch 4DM with the
user configured workflow
until it is deleted from
the Edit Command Line
Arguments field.

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE

Applications Panel

The functionality to apply an action to patient files is located in patient browser’s right panel. This panel
is divided into two areas: the top half is the Applications panel providing button controls for launching
additional applications; the bottom half is the Destinations panel providing file transfer capabilities.

4DM

To open desired files in 4DM for study review, the user simply needs to select the specific files and then
click the 4DM button in the Applications panel (see @ Figure 2.16). If the user selects a patient file that
does not contain patient images, clicking the 4DM button will open 4DM Reporting.

Sources. Search Applestions
Banees e Actusien Humbas
| Patont 0 Sty Deserption ~ EE"'DM — o!
(O W Cotsbase: detat Magusty: Series Deserigton L 4
- EProgramDats Oocements WA ormidardDbhSamedeCats Yoo <||2@ =] md [ =llree -1l - |E4 A0u Rporing Q:
— 7 S 3)
.

Sty Dwce: a1 Dates - [ -

Patiesd List

7 Maige Patent
& Pateri Rams Fatast O MostAscentS. WofShdes  Locaten
40u 0875201 COSOIGAPSLA.  J0My2%S 1 c
y 0at. e
ACad PET PR 008 DOLCCINBEINCE.  IBOCLION 1 € rogrant comoraansanpe | oL
4Cu FETS0 BOSONRBEZFE. GlMuyames 1 € ~
wuserzen ctecor oI a1 PP S———————— .
40U SPECT.CT.001 COLONINOSR-.. AT 1 c

[O W atase: detwut
7 iy Competee | O 3% oicom canie

ik = Actwe Joba: (), Completed Joba: . Last Job Status: Unkenown: [ [FoPaens 5 [Fd Sudes 5 EdSemst  [Fd

= %

Figure 2.16: Select files to open in the browser window

4DM Reporting

For users who do not need to access 4DM, but simply
need to create or edit a report, use the 4DM Reporting

Application Mame: Corridor4DM

button (see @ Figure 2.16). Refer to Chapter 3 to

. . Command Line Arguments:  -user DrSPECTReview
learn more about the various use-cases of accessing

[ ok ][ cancel |

4DM Reporting from the patient browser.

Figure 2.17: Right-click to access the
Command Line Window

DICOM Editor
The DICOM Editor is accessed | .oumoms
through the Application Panel e — B T T el
(see © Figure 2.16). The DICOM o ——— e ———— [
Swllic Accession Mumber: [roesss e  Undefined

Editor (Figure 2.18) can be used to

view patient DICOM information, [ e —— C——
anonymize patient data, review g F T % S
entire DICOM attributes and edit T
DICOM attributes in the selected | swasemwoea
file. B [ ] ]
o ol ! o
To load a patient into the editor,

select it from the Patient List and
click the DICOM Editor button
from the Applications panel.

Save Cancel

Figure 2.18: DICOM Editor

CHAPTER 2: USING CORRIDOR BROWSER = 9



The check box

for Anonymize
Miscellaneous
Information is
deselected by default.
If selected, it will
anonymize multiple
miscellaneous DICOM
fields including:
Institution Name,
Institution Address,
Referring Physician
Name, Patient Insurance
Code, and more.

If the patient is located
in a Database the
Overwrite option is
disabled.

4DM PERSONAL'S PATIENT BROWSER =

To Anonymize a Patient Name:

= Select Anonymize Patient Name (Figure 2.19)
— When the button is activated it will

—File Export Settings

clear the First Name, Middle Name,
Last Name, Prefix and Suffix fields.
The Last Name field will display
ANON followed by the first three
characters of last name and the first

Anonymize Patient Name ™ Anonymize Miscellaneous Information

Anonymize Patient ID |

Review Entire File |

character of first name. (i.e., John
Doe becomes ANONDOEY)

Figure 2.19: DICOM Editor - Anonymize Patient Name

To Anonymize a Patient ID:

= Select Anonymize Patient ID (Figure 2.20)
— When the button is activated it will

clear the ID Number field and then
display ANON followed by first
four digits of ID Number followed
by date and time on system at
time of edit. (i.e., ID NUMBER

—File Export Settings

Anonymize Patient Mame

™ Anonymize Miscellaneous Information

Anonymize Patient ID

Review Entire File |

is 12345678 edit occurred on
9/8/2009 at 12:12:12pm, becomes
ANON123420090809121212)

Figure 2.20: DICOM Editor - Anonymize Patient ID

To Review DICOM file:

—File Export Settings
= Select Review Entire File (Figure 2.21)

Anonymize Patient Name ™ Anonymize Miscellaneous Information

= A text file will open in Notepad listing
the DICOM attributes for the selected
dataset

Anonymize Patient ID

Review Entire File

= Displayed fields are not editable Figure 2.21: DICOM Editor - Review Entire File

To Edit DICOM information in a selected file:
= Choose a field you want to edit
— Editable fields are indicated by a text box and allows free text editing

= Click Save to overwrite the original file passed to the editor or Cancel to exit without edits

To Generate New Patient from a selected file:
= Edit the Patient Name or Patient ID
— The New Patient button is now available

= Click New Patient to generate the newly defined patient with a copy of all other DICOM
fields loaded into the editor

USER'S GUIDE
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Merge Patient

Merging a patient consolidates two patient records into one, in the event that a duplicate has been created
in error. [When a patient report is intentionally started separately from the patient’s image file, in order to
fill-in patient information, ECG data, etc., use the Merge feature within 4DM Reporting as described in
in the “Combine Reporting Values with 4DM Image Data” section of the 4DM Reporting User’s Guide
to combine the image data and reporting values into a single report.]

Two example use cases of the Merge Patient functionality in the patient browser are:

1. If a user created a preliminary report within 4DM Reporting for “Jon Smith” (incorrect
spelling) and then later imported a patient named “John Smith” (correct spelling) from the
worklist and acquired patient images.

= Two patients would be created since the names do not match.

= Merging Jon Smith’s preliminary report into John Smith’s image data would create a
single file that contains both the patient information as well as the patient images.

2. If patient images were acquired under the wrong patient entirely — e.g., the user selected
“Jane Smith” from the worklist and acquired patient images, when the user should have
selected “John Smith.”

= Two patients would be created since the names do not match.

= Merging Jane Smith’s patient images into John Smith’s patient file would reassign
the images to the correct patient.
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o e OOSOTARBEZ(FE. G2dMyamed 1 PISI— i:’_‘_ L . =2
Jahin A Smith MO IDGIR(L. NI 1 e —— T p—

JahnSmith 000N WOESAL. IRMAIET 1 POt | Use these controls to merge two patients into @ single patient.

Patient 1:

Patient Name Patient I

John A Smith 004-001,1D GER (schemic2)  Made 13-4dar- 1954
Patient 2 "
Patient Hame Patient 1D F P

Jofn Smit 00400110 GIR (Ischemicz)  Male 13-Mar-1854

Figure 2.22: Merge Patient tool

To combine two patient files into one, select both files in the patient list, and click Merge Patient (Figure
2.22). In the Merge Patient window, select the Up arrow to merge Patient 2 into Patient 1, or select the
Down arrow to merge Patient 1 into Patient 2.

During the merge, any DICOM datasets from the other patient file are added to that master patient file.
Note that DICOM datasets are always added to the master patient file, never overwritten.

The patient file the user merges into will dictate the Patient Name, Patient ID, Gender, and Date
of Birth that the patient file retains. All other demographics and medical history information that are
retained will be taken from the more recently saved patient information file.

A pop-up window allows the user to delete or keep the secondary patient file. Note that, during the
merge, the user will not have the option to select which fields to keep or overwrite.
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Destinations Panel (Figure 2.23)

To copy patients to a database: Destinations
= Select specific patient files [+ | N2
= Select the target database B Datsbase: defauit
= Click the Copy To tool (Figure 2.24) O 3% DICOM: ReadingRoom
O 7 cWsers\PublicDocuments\INVIACorridordDMSampleData

To co atients to a DICOM node:
Py p Figure 2.23: Destination Panel

= Select specific patient files
= Select the target DICOM node
= Click once on Copy To tool

Figure 2.24: Copy To tool

To copy patients to a New Directory:

= First, create a new directory
— Click the Add Local (Figure 2.25) button Figure 2.25: Add Local tool
— Select the desired directory lﬂ
— Select OK

= The new directory path will appear in the Destinations panel
— Select specific patient files
— Select the target directory

= Click once on Copy To tool

Right-click on the status The patient browser interface provides a Status Bar along the bottom of the patient browser screen. There
bar to display the last 100
actions in a window.

are five display panels on the Status Bar (Figure 2.26):

[Pob Gueue - Active Jobs: 0, Completed Jobs: 0. Last Job Status: Unknown [#cf Panding Results: 10 [#of Patients: 5 [Hof Sudes: 5 [Sof Senes: 5 [& of Images/Instances: 5
Figure 2.26: Status Bar

= Job Queue: The number of Active Jobs and Completed Jobs will be displayed in addition
to Last Job Status. If an error occurs, the Failed status window will be displayed and
provide the reason of failure.
— Left-click on the Job Queue to view the Job Queue Manager.

= Job Queue Manager: Displays Status, Timestamp, Type and Details for both Active Jobs
and Completed Jobs.
— Active Jobs: The user can View Job Details, Move Job Up, Move Job Down, Cancel Job
and Pause/Resume Job in the Job Queue Manager.

— Completed Jobs: The user can View Job Details and Delete/Clear All jobs in the Job Queue
Manager.

= Action Status: Displays Copying actions.

= Number of Pending Results: Denotes the number of DICOM result files from Corridor4DM
pending import into a database.

= Number of Patients: The number displayed depends on the Patient Display List
— Displays the total number of selected patient files.

= Number of Studies: The number displayed depends on the Patient Display List
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— Displays the total number of selected study files

= Number of Series: The number displayed depends on the Patient Display List
— Displays the total number of selected series files

= Number of Instances: The number displayed depends on the Patient Display List
— Displays the total number of selected instance files. (Only available on the Local tab. On the
Remote Tab, the display panel is always blank.)
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CHAPTER 3

START OR EDIT A REPORT

To enter patient information into a report prior to obtaining the patient study, start the report from the

patient browser.

To start a report in 4DM Personal, do not select any patients within the Patient List, and click 4DM

Reporting (Figure 3.1). ADM’s integrated reporting interface opens in a new window as a blank slate to

begin entering patient information such as Demographics or Medical History.
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Figure 3.1: Start a Report from 4DM Personal's Patient Browser

To learn more about 4DM Reporting, refer to the 4DM
Reporting User'’s Guide, accessible from the Help Menu
in 4DM Reporting (Figure 3.2).

“

Figure 3.2: Help button in 4DM Reporting

Locate and select the patient file from the Patient List and click the 4DM Reporting button in the
Application Panel (Figure 3.3). ADM’s integrated reporting interface opens in a new window with any

previously saved patient information and imaging information displayed.
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Note that depending on the template you have selected, some reporting screens may not be accessible.
To change the reporting template, simply click the Template Selector (see @ Figure 3.3) and choose a
different template. For more information on templates, refer to the 4DM Reporting User s Guide.
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Figure 3.3: Edit an Existing Report from 4DM Personal s Patient Browser
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CHAPTER 4 | DATABASE MANAGEMENT

The Database Manager window (Figure 4.1) is accessible from the Tools menu and permits the user to
add and delete databases as well as manage database files.

Database Instances:

Name Size (MB) Entries Clean Up Schedule Auto-Routing
defaul 0.01 3 Never Delete Newver Auto-Route
Training 0.01 0 HNever Delete HNever Auto-Route

Databases have an

&
advantage over folders !,
=~
o

when it comes to patient

& file storage. Queries

return search results in

less time. Also, users can
efficiently add and delete
files.

Figure 4.1: Creating a new data storage location using the Database Manager

These are the Database Manager tools:

= Database Information: (Figure 4.2) Provides details about the Figure 4.2:
selected database (Database ID, Database Filename, Database H] Database
Location and Type (local or network). Left-click to access the Information Tool

following database tools (Figure 4.3):

@ Test Database Connectivity: Tests the connectivity between

If All Studies Older Than the patient browser and the selected database. This is useful for r (1]
a certain number of days troubleshooting issues with networked databases.
is selected, comparison @ Database Cleanup Schedule: This tool provides a window where the
studies that are older . )
& than the defined day user can define an automatic cleanup schedule to reduce the size of an !, (2]
range in the database will image database. Within this window, the user can define the time the
be deleted during the scheduled cleanup will occur and the criteria for what files are to be
Database Cleanup Time. deleted when threshold limits are reached. & (3)
© Rebuild Database Index: Reconciles the number of database entries
with the number of files.

@ Compact Databases: Reclaims wasted space within the databases and
improves performance.

© Database Auto-Routing Schedule: This tool provides a window
where the user can specify a DICOM destination where images will be
automatically transferred. This is primarily used for pushing results to
a PACS system. For each database, the user can specify one or more

m

destination DICOM nodes (Auto-Routing Nodes), a start date after Figure 4.3:

. . . . L Database
which all image files will automatically transfer to the destination(s), Information Window
and the schedule time when the automatic transfer will occur. Tools
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= Add/Link Database: (Figure 4.4) Creates or links a database and adds it to the Sources and
Destination panels.

= Rename Database: (Figure 4.5) Edit the selected database name.

= Unlink Database: (Figure 4.6) Unlink the selected database from the system and remove it
from the lists in the Sources panel and Destinations panel without deleting all related data

Want to collect from the system.

interesting cases in a

) = Delete Database: (Figure 4.7) Deletes the database from the database list in the Sources
single database? Create

» a custom database and panel, Destinations panel, and all related data from the system. This operation cannot be
copy patient files using reversed.
the patient browser file
transfer functionality. = Refresh: (Figure 4.8) Updates the current list of the database tables.
Figure 4.4: Add/ Figure 4.5: Rename Figure 4.6: Unlink Figure 4.7: Delete Figure 4.8: Refresh
Link Database Database Tool Database Tool Database Tool Tool
Tool

Creating a Local Database for Image Storage

Users can build multiple databases to catalog patient [E

data for specific uses. As an example, this guide will | e =
illustrate creating a Training database. L =
1. Open the Database Manager window from | *&
the Tools menu .
2. Select Add/Link Database tool
3. Create a new File name (see @ Figure 4.9)
Files type will remain INVIA Database
(*.icbd)
File geme: Training.icbd - @A Databaze (i) =
5. Select Open to complete the task (1 o

The new database name will appear

. . F' .9: 2 . .
automatlcally in the Database Manager igure 4.9: Creating a new database in the patient browser

Creating a Network Database for Image Storage

Prior to creating a network database, you will need to insure that the directory on the remote computer
is shared to the network. You also need to insure that the security settings for this directory allows for
remote users to read and write files to this directory. Once sharing and security are defined on the remote

computer:
1. Open the Database Manager window from the Tools menu
2. Select Add/Link Database
3. Navigate to the shared directory
4. Create a new File name (e.g. Training)
5. Files type will remain INVIA Database (*.icbd)
6. Select Open to complete the task
7. The new database name will appear automatically in the Database Manager
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CHAPTER 5

SCP vs. SCU

These two terms

are important for
understanding the
communication
capabilities of DICOM
compliant workstations.

A Service Class User
(SCU) is a device that
requests a DICOM
Service, typically a client
requesting information or
data from an SCP.

& A Service Class Provider

(SCP) is the device that
provides the service to an
SCU, e.g. image storage,
image query with image
storage.

The patient browser
provides connectivity for
both of these services.
Databases or folders
saved in the Sources
panel act as SCUs while
databases or folders
saved in the Destinations
panel act as SCPs.

The Station Name will
identify the Corridor
Browser-based SCP
within the network.
This SCP will initially
listen on all available
IP addresses. If no IP
address is available,
None will appear as the
IP address and the SCP
service will remain off
until an IP address is
available or defined.

When defining a port,
users should confirm that
the port is not used by

& another network service.
Consult your IT manager
for assistance.

DICOM CONFIGURATION

Upon installation, 4DM Personal’s Patient Browser will configure a base Service Class Provider (SCP)

using the following parameters:

1. Station Name (by default, this will be the computer’s name)
. Application Entity (AE) Title (same as Station Name by default)

. Port # (automatically generated with first available port starting with Port 104)

2
3
4. 1P address or addresses
5

. Data Storage (“Database: Default” is assigned upon installation)

Base SCP Configuration

Initiating the Base SCP

Once the patient browser is installed, users
must turn on the Base SCP so Corridor
for other DICOM

Browser can “listen”

workstations.

1. Launch the patient browser

2. Select Local SCP Configuration
from the Tools menu at the top of
the Corridor Browser interface

3. Inthe Local SCP Configuration
(Figure 5.1) window, verify that
the SCP status is on and click OK

All SCPs need the type of file storage defined (e.g.,
database or files). The base SCP will store transferred
files to the default database created at installation.

Customizing the Base SCP Configuration
= In the Local SCP Configuration

Base SCP Configuration
Saton lame: READING_ROOM P Asiess
AETitle: READING_ROOM  scp siams
Port, 104 ® on @ off
Additional Local SCPs.
AE Title Port Location Status
AETitle: SCP Status
Port © on ® off
Data Storage: |Database: -
Register SCP Service ok Cancel

Figure 5.1: The Local SCP Configuration window

window, customize the following fields in the Base SCP Configuration panel (Figure 5.2):

— Station Name
— AE Title

— Port

— 1P

Assigning a Database to

Base SCP Configuration

the Base SCP

= In the Local SCP
Configuration

AE Title:

Data Storage:
window, select the

Station Name: READING_ROOM
READING_ROOM

Port:

SCP Status
104 © On @ off
:

Data Storage drop-
down menu

Figure 5.2: The SCP Base Configuration area is the top panel

within the Local SCP Configuration window
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Any changes to the Base
SCP and Additional
Local SCPs will cause it
to automatically stop and
restart. This is a “behind
the scenes” action and
generally takes less than
30 seconds. Any changes
to an SCP should not
occur during data
transfers.

Users can organize files
within the SCP root
folder by selecting a first
and second subdirectory.
Data can be arranged by:

= Patient Name
= Patient ID

= Modality

= Study Date
= None

When defining a port,
users should confirm that
the port is not used by
another network service.
Consult your IT manager
for assistance.
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= Select Database (Figure 5.3)
= Select the desired database in the second drop-down menu T

— If the default database is the only available option, you can

reference Chapter 4 to create a new database

-

default
Training I

Figure 5.3: Database
selection options

Assigning File Location to the Base SCP

= In the Local SCP Configuration window, select the Data Storage drop down menu in the
Base SCP Configuration panel (top):
= Select Files
= The following fields are now available for edit:
— Root Directory (Browse): Main location of the directory
— 1st Subdirectory: First level of the directory organization
— 2nd Subdirectory: Second level of the directory organization (Figure 5.4)

Data Storage: |Files -

RootDirectory:

15t Subdirectory: | Patient Name -

II

2nd Subdirectory: | Modality

For Example: <=Root Directory=/=Patient Mame=/<Modality=/...

Figure 5.4: Example of the file directory structure

Additional Local SCPs

Creating Additional Local SCPs

= In the Local SCP Configuration window, make the following edits in the Additional Local
SCPs panel (Figure 5.5):
— Enter a unique AE Title and Port #
— Set the Data Storage location
— Turn SCP Status On
— Click the Add tool (Figure 5.6)

Additional Local SCPs

AE Title Port Location Status
AETitle: SmithDffice SCP Status 1
Figure 5.6:
Port: 105 @ On O off
Add Tool

Figure 5.5: The Additional Local SCP area is the bottom panel within
the Local SCP Configuration window.
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When the SCP status

is turned Off, remote

DICOM work stations
& will not be able to

transfer files to Corridor

Browser.

Assigning a Database to an Additional SCP

In the Local SCP Configuration window, make the following edits in the Additional Local

SCPs panel:

— For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating

Additional Local SCP’s section above), then continue to next step

— For an existing SCP, select the SCP in the list and continue to next step

Go to the Data Storage drop down menu
Select Database
Select desired database in the second drop down menu

— If the default database is the only available option, you can reference

Chapter 4 to create a new database

+

For a new SCP, click the Add tool (Figure 5.7) and then click OK /

For an existing SCP, click the Edit tool (Figure 5.8) and then click OK

Assigning File Location to an Additional SCP

= For a new SCP, click Add Local SCP and then click OK

Launch the patient browser
Select Local SCP Configuration from the Tools menu

Figure 5.7:
Add Tool

Figure 5.8:
Edit Tool

In the Local SCP Configuration window, make the following edits in the Additional Local

SCPs panel (bottom):

— For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating

Additional Local SCP’s section above), then continue to next step

— For an existing SCP, select the SCP in the list and continue to next step

Go to the Data Storage drop down menu

Select Files

A new window will open to set the following fields
The following fields are now available for edit:

— Root Directory (Browse): Main location of the directory
— Ist Subdirectory: 1st level of the directory organization

— 2nd Subdirectory: 2nd level of the directory organization (Figure 5.9)

Data Storage: | Files
RootDirectory:

15t Subdirectory: | Patient Name -

{

2nd Subdirectory: | Modality

Browse...

Figure 5.9: Example of the file directory structure

= For an existing SCP, click Edit Local SCP and then click OK

SCP Services

Change the Base SCP Status

Set the SCP Status toggle (On or Off) (Figure 5.10)
Click OK

SCP Status
@ On

i) Off

Figure 5.10: The SCP Status Toggle
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Change an Additional SCP Status

1. Select the Additional SCP to be modified
2. Set the SCP Status Toggle (On or Off)
3. Click the Edit tool

4. Click OK

Deleting an SCP

Users cannot delete the

/ Base SCP; it can only be To permanently remove a custom SCP, select it from the Additional Local ":'__ Figure 5.11:
deactivated (turned off). SCP list, click the Delete (Figure 5.11) tool and then click OK to close the :._ Delete Tool
-
window.
Register SCP Service

For systems using the Windows Firewall (recommended), this button will register the CorridorSCP
application with the firewall. By doing so, the patient browser allows outside computers to query and
store images to the local SCP.

DICOM Node Configuration

The Name field identifies Adding a DICOM Workstation to the Sources and/or Destination Lists

the remote DICOM .

o . = Select DICOM Node Configuration
node within Corridor

/ Browser. Use a unique from the Tools menu
name associated with . Select DICOM node:
= In the DICOM Node Configuration Name AeTe Pagress  Pot Ty

that system (e.g. Camera ) .
Room One). window (Figure 5.12), click the New

tool (Figure 5.13)

= Enter a unique Name in the DICOM
Node Settings window (Figure 5.14)

= Enter the AE Title for the DICOM =
WARNING workstation to which you want to
Remote DICOM connect Figure 5.12: DICOM Node Configuration window

workstations will need

= Confirm that the DICOM Port on the

to be configured to

recognize Corridor remote workstation is 104 (change it if necessary) ﬁ Figure 5.13:
Browser SCPs. Refer to ., f]aﬁﬁ New Tool
the workstation user’s = Enter the DICOM workstation’s IP Address

manual or contact a

= Select the desired Type for the DICOM Node
— Query: Adds the new DICOM Node to the

[ DICOM Node Settngs

service representative for

assistance.
' Sources panel on the Remote tab Name:
® Information necessary
o complete this step — Storej. Afids the new DICOM Node to the AE Title:
includes AE Title, Port #, Destinations panel on the Local and Remote tabs Port 104
d IP add fi h . . . ,
and Hacdress for eac = Click Test to confirm the DICOM connection is IP Address: : ) ]
workstation.
successful Type: (V] Query [#] Store
For more information = Click OK to close the Test window
on remote workstation . . Test oK Cancel
configuration, visit = If passed, click OK on the DICOM Node Settings
www.inviasolutions.com and DICOM Node Configuration windows to save
settings Figure 5.14: DICOM Node Settings
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Editing a Previously Added DICOM Node
= Click the desired DICOM node from the DICOM Node Configuration window (Figure 5.15)

= Click the Edit tool. E DICOM Node Configuration

= Make the necessary changes on the
Select DICOM node: - |.
Port Type

DICOM Node Settings window - P orssens
= Click the Test tool to confirm the = Test 123456789 104 QueryiStore

DICOM connection is successful
= Click OK to close the Test window
= If passed, click OK on the DICOM
Node Settings and DICOM Node
Configuration windows to save o)

settings Figure 5.15: Create, edit, delete, and test DICOM Nodes

Deleting a Previously Added DICOM Node

= Select DICOM Node Configuration from the Tools menu
= Click the desired DICOM node

= Click the Delete tool then OK to close the window

The the patient browser will enable the user to import a specific image file type (i.e. DICOM,
Pegasys, ECAT) from a Windows directory folder automatically into the local DICOM SCP data
storage location. The files are deleted from the Windows directory folder after the transfer has
completed.

How to Configure

1. Select Auto Import from the Tools menu found on the top Menu Bar.
2. Click Browse to navigate and select the Windows directory folder.
3. Select the Data Format for incoming image file types.
=  DICOM - If selected, only DICOM files are read and pushed to the SCP.

= Pegasys — This selection will only read and convert Pegasys formatted image files.
If selected prior to sending to the SCP, the files are converted from Pegasys format to
INVIA DICOM format.

=  ECAT - This selection will only read and convert ECAT 7 formatted image files. If
selected prior to sending to the SCP, the files are converted from ECAT format to
INVIA DICOM format.

4. Select the Data Destination then Add.

The user can remove a Windows directory folder from the Auto Import directory list by clicking
Delete.

Troubleshooting Auto-Import

During the conversion process, a “Pending” folder will be generated within the Auto Import specified
directory folder as a temporary placeholder for files awaiting conversion.
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If the conversion process fails, then a “Failed” folder will be created within the Auto Import specified
directory folder containing the files that failed the conversion process.

If the user is trying to configure an auto import rule and there are not any options displayed in the data
destination drop down menu, the user will need to turn “on” the Local Base SCP Configuration.

Within the the patient browser’s Help menu, users can review a record of DICOM activity. The following
logs are available:

= Event Viewer: Records all events and actions for all instances of the patient browser
that are running. This information is used to track potential errors in the operation of the

Only one file type can be application which is useful for INVIA to troubleshoot problems with the application.

configured per directory.

— Select Event Viewer from the Help menu
& Different image file

— Once the Event Viewer is open, select INVIA from the list to view log entries
formats need to be sent to

separate Windows — To save the INVIA log to aide in advanced troubleshooting

directory folders. * Right-click on INVIA
* Select Save Log File As...

= 4DM Personal’s Patient Browser Log Viewer: Provides a real time display of all actions
and events executed by the currently active patient browser. When a problem has occurred
with the application, this tool can help record the specific steps. This tool will be used by
INVIA to troubleshoot problems with the patient browser.
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CHAPTER 6

A O

Local to Local

DATA MANAGEMENT

4DM Personal’s Patient Browser is designed to provide an interface for DICOM file management. This
section will provide examples of file retrieval and transfer from a variety of sources.

Follow this tutorial to transfer DICOM files from local sources (folders or databases) to local destina-
tions (folders or databases). Refer to Chapter 2 for help creating local sources and destinations.

Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\Docu-
ments\INVIA\Corridor4DM\SampleData)

Click the Refresh tool in the Patient List Panel to display a list of patient files

Select files for transfer

Click the desired Local Destination so it is selected

Select the Copy To tool

Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete
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Figure 6.1: Local to Local Data Transfers
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Local to DICOM (Remote)

Follow this tutorial to transfer DICOM files from local sources to remote destinations. Refer
to Chapter 2 for help creating local sources and Chapter 5 for help creating remote DICOM

workstations.

1. Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\
Documents\INVIA\Corridor4dDM\SampleData)

3. Select files for transfer

5. Select the Copy To tool

Click the desired DICOM (Remote) Destination so it is selected

Click the Refresh tool in the Patient List Panel to display a list of patient files

6. Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete
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Figure 6.2: Local to DICOM (Remote) Data Transfers
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DICOM (Remote) to Local

In order to transfer
data from a remote

Follow this tutorial to transfer DICOM files from remote sources to your PC. Refer to Chapter 5 for

workstation to your PC,

& you'll need to start the help creating Remote DICOM sources and destinations and Chapter 5 for help creating additional
default SCP service. Local sources and destinations.
Refer to Chapter 5 for
step-by-step instructions. 1. Click the Remote tab

2. Select the desired DICOM Source (e.g., DICOM: InterestingCases)

3. Once the data source is selected, click the Refresh tool in the Patient List Panel to display a
list of patient files

4. Select files for transfer

5. Select the DICOM Destination labeled with your AE Title (e.g., DICOM:ReadingRoom).
This will send the data to the location defined in the Local SCP Configuration

During installation,
the patient browser
names the Base SCP 6. Select the Copy To tool
with the same name

already assigned to your 7

Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

computer.
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Figure 6.3: DICOM (Remote) to Local Data Transfers
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DICOM (Remote) to DICOM (Remote)

Follow this tutorial to transfer DICOM files from remote DICOM sources to another remote

DICOM destinations. Refer to Chapter 5 for help creating remote DICOM sources and

workstations.

1. Click the Remote tab

2. Select the desired DICOM Source (e.g., DICOM: InterestingCases)

3. Once the data source is selected, click the Refresh tool in the Patient List Panel to display

a list of patient files

4. Select files for transfer

5. Select the DICOM Destination (e.g., DICOM:Clinic).

6. Select the Copy To tool

7. Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete
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4 Figure 6.4: DICOM (Remote) to DICOM (Remote)

0 Data Transfers

4DM Personal’s Patient Browser provides the ability to Backup, Restore, 1
and configure Options within Preferences. To access these settings, click
Tools and select Preferences (Figure 5.5) to open the patient browser’s g

Preferences window.

Backup

The Backup tab (Figure 5.6) enables the user to define

a Backup Directory location and specify which options
to select under Backup Global Settings/Directories and
the Backup Format when performing patient browser’s
Preference Backup. This should be performed after the
initial setup of the patient browser.

File Help

Loca Database Manager

Local SCP Configuration
DICOM Node Configuration
Job Queue Manager

Preferences

Auto Import

] DICOM et Cantgutatan

) Loewl 507 Candpurasen

T Breeece Semegy

(o) e

Figure 6.6: Patient Browsers Preferences - Backup
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Restore [EEper—s LT

Bacap | Femoe | Gotors

The Restore tab (Figure 5.7) enables the user to Rt Dencty -
specify the directory location of the patient browser’s —
Preference Backup using the Restore Directory. ——

Under Restore Global Settings/Directories, the user
selects from available options contained in the patient

browser’s Preference Backup to restore the patient

browser settings.

|

Figure 6.7: Patient Browser s Preferences - Restore

T

Backup | Fnetor || Cotors

Options

The Options tab (Figure 5.8) provides settings for

Aust Loggeg

Audit Logging to track user activity within the patient

browser, Language Setting if the user wants to set a

language used in 4DM different from the Windows ..,_..‘.: —
0OS, and DICOMDIR support for exporting datasets roareeiomreee g 2

with a DICOMDIR included. .

Enatis CCOMEH supon [

Audit Logging

Save Cancel

This feature enables the ability to track access and Figure 6.8: Patient Browser s Preferences - Options
changes to patient files by turning the option on or off.

When activated, the patient browser records:

= Windows User Name
= Date and time of action
= What the action was:
» Querying patient files: records the source file location of the patient and any search
parameters used to locate the patient file

» Copying of a patient file to a new location: records the Patient Name, ID, Source,
and Destination that the patient file was copied to

» Launching a patient file: records the Patient Name, ID, and Application that the
patient was launched into (e.g., 4DM or 4DM Reporting)

= Security tag to allow detection of log file tampering

Within the Audit Logging section of the Options window, the user has the ability to specify the
Audit Log Location to retrieve the log files. To retrieve or access a log, navigate out to the
directory location and open the XML log file. You can choose to open the file in Excel, Word,
Notepad, or any other application that reads XML.

Logs are saved with dates and times in the filenames so you can easily locate a specific log.
Sequential sessions of 4DM are logged in the same file, until that file reaches the maximum file
size as defined by the Administrator.

Within the Options window, the user can also:

1. Define Maximum Log File Size: The amount of disk space each audit log will occupy
prior to creating a new log.

2. Backup: The user can backup audit logs to a secondary location. Clicking Backup opens a
window where the user can choose a location to automatically store backup log files.

3. Validate: Clicking Validate opens a Validation Report which verifies that no manual
edits have made to the log file. Note that only Admin Users have read/write access for the
log file.
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